
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
Lesson Exemplar for TLE Grade 8 
Quarter 1:  Lesson 4 (Week 4) 
SY/TP 2025-2026 

 
 This material is intended exclusively for the use of teachers participating in the pilot implementation of the MATATAG K to 10 Curriculum during the 
School Year 2025-2026. It aims to assist in delivering the curriculum content, standards, and lesson competencies. Any unauthorized reproduction, 
distribution, modification, or utilization of this material beyond the designated scope is strictly prohibited and may result in appropriate legal actions and 
disciplinary measures. 
 
 Borrowed content included in this material are owned by their respective copyright holders. Every effort has been made to locate and obtain permission 
to use these materials from their respective copyright owners. The publisher and development team do not represent nor claim ownership over them. 
 

 
 

Every care has been taken to ensure the accuracy of the information provided in this material. For inquiries or feedback, please write or call the Office 
of the Director of the Bureau of Learning Resources via telephone numbers (02) 8634-1072 and 8631-6922 or by email at blr.od@deped.gov.ph 
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TLE / QUARTER 1 / GRADE 8 

I. CURRICULUM CONTENT, STANDARDS, AND LESSON COMPETENCIES      

A. Content 

Standards 

The learners demonstrate an understanding of graphic design tools. 

B. Performance 

Standards  

The learners create videos with graphics design in a safe and responsible manner 

C. Learning 

Competencies  

and Objectives

  

Learning Competency 

The learners will 

● utilize graphic design tools for graphic production 

 

Learning Objectives 

At the end of the lesson, the students are expected to: 

1. identify common graphic design tools and their functions. 

2. demonstrate how to use graphic design tools to create designs. 

3. appreciate the importance of graphic design principles in creating visually appealing projects. 

D. Content Graphic Design Software  

A. Introduction to Adobe Photoshop 

a. Basic Functions of Adobe Photoshop 

b. Setting Up a Document 

c. Navigation 

B. Composition Techniques 

a. Flyer/Magazine Cover Making 

E. Integration Technology literacy 

Visual aesthetics 

 

II. LEARNING RESOURCES 

Envato Tuts+. (2020, April 27). How to create a promotional flyer in Photoshop [Video]. YouTube. 

https://www.youtube.com/watch?v=G7GGVWeWddg  
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Farley, J. (2022, October 27). Getting started with Photoshop – the workspace. Photoshop for Beginners. 

https://www.photoshop-bootcamp.com/getting-started-with-photoshop/#getting-around-the-photoshop-workspace  

Fiverr. (2023, October 5). How to choose the perfect branding colors (+ examples). Fiverr.com. 

https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand  

Good Graphics. (2023, November 3). Make a simple flyer design using Photoshop: Step-By-Step [Video]. YouTube. 

https://www.youtube.com/watch?v=CuME6eLA3kw   

Patterson, S. (2023, September 22). Photoshop tools and toolbar overview. Photoshop Essentials. 

https://www.photoshopessentials.com/basics/photoshop-tools-toolbar-overview/   

Photoshop Online Training Courses | LinkedIn Learning, formerly Lynda.com. (n.d.). LinkedIn. 

https://www.linkedin.com/learning/topics/photoshop?trk=lynda_redirect_learning  

Solopress. (2022, April 8). How to design flyers & leaflets in Photoshop - Adobe Tutorial [Video]. YouTube. 

https://www.youtube.com/watch?v=prG-OpkJ9Xk  

Walker, A. (2024, February 24). What is Photoshop? Introduction, Meaning, Definition & History. Guru99. 

https://www.guru99.com/introduction-to-photoshop-cc.html  

 

III. TEACHING AND LEARNING PROCEDURE NOTES TO TEACHERS 

A. Activating Prior 

Knowledge 

 

DAY 1 

1. Short Review 

Brainstorming. Engage students by showing examples of graphic design projects and asking 

them to identify the tools used. 

● How do you think those pictures were created? 

● What are the tools they used to enhance the design? 

 

 

 

 

 

 

 

 

 

 

 

 

 

The teacher may ask 

students to bring some 

examples of edited 

photos, magazine cover, 

design, etc. which will be 

discussed in the 

classroom. 
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2. Feedback (Optional) 

B. Establishing 

Lesson Purpose 

1. Lesson Purpose  

This lesson will teach the students to use the Graphic Design application (Adobe Photoshop) 

by creating visually appealing projects in a responsible manner. 

 

2. Unlocking Content Area Vocabulary 

 

● Adobe Photoshop - is a powerful photo and image editing application. Part of the Adobe 

Suite of productivity software and considered by many to be a benchmark in the world of 

professional digital image solutions. 

● Resolution refers to the number of dots per inch (dpi) that appear in your images final 

form. For print these really may just be dots. On screen, however, these dots are referred 

to as pixels. 

● Raster (also called "Bitmap") graphics are created from rows of different colored pixels 

that together form an image.  

● Vector (also known as "object-oriented") graphics are constructed using mathematical 

formulas describing shapes, colors, and placement. Rather than a grid of pixels, a vector 

graphic consists of shapes, curves, lines, and text which together make a picture. 

 

Start with a brief 

icebreaker to set a 

positive and interactive 

tone. Ask them to share 

their observations. 

C. Developing and 

Deepening 

Understanding 

SUB-TOPIC 1: Introduction to Graphics Design 

 

1. Explicitation  

Adobe Photoshop is a powerful raster graphics editor developed by Adobe Inc. It is widely used 

by graphic designers, photographers, and digital artists for various purposes such as photo 

editing, image manipulation, graphic design, digital painting, and much more.  

 

Although it is possible to design and construct original graphics, Photoshop is mainly for 

editing images, not creating them. 

Photoshop is best used for working with images you already have, like editing, combining, 

and converting them. 

 

 

 

Adobe Photoshop should 

be downloaded and 

installed to the 

Computer Units before 

the start of this lesson. A 

download link was 

shared for the trial 

version if the school 

/teacher has no account 

yet. 
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Download a free trial version of Photoshop on this Link: 

https://www.adobe.com/products/photoshop.html?clickref=1011lyqBk7DY&mv=affiliate&

mv2=pz&as_camptype=&as_channel=affiliate&as_source=partnerize&as_campaign=softonic 

 

Basic Functions of Adobe Photoshop 

Here's an introduction to some of its key features and functionalities: 

A. Layers: Photoshop works with layers, allowing users to stack different elements of an 

image on top of each other. This non-destructive editing approach enables users to make 

changes to individual elements without affecting the rest of the image. 

 

B. Image Adjustments: Photoshop offers a wide range of adjustment tools and commands 

for tweaking the colors, tones, and overall appearance of images. This includes 

adjustments such as brightness/contrast, levels, curves, hue/saturation, and more. 

 

C. Masking and Compositing: Masks allow users to hide or reveal portions of an image 

selectively. This is particularly useful for combining multiple images or adjusting specific 

areas without affecting the rest of the image. 

 

D. Color Management: Photoshop supports various color modes and color profiles, allowing 

users to work with different color spaces and ensure accurate color reproduction across 

different devices. 

 

E. Exporting and Saving: Photoshop enables users to save their work in various file 

formats, including PSD (Photoshop Document) for retaining layers and editing 

capabilities, as well as formats like JPEG, PNG, TIFF, etc., for sharing and publishing. 

 

F. Integration with Adobe Creative Cloud: Photoshop seamlessly integrates with other 

Adobe Creative Cloud applications like Adobe Illustrator, Adobe InDesign, and Adobe 

Lightroom, allowing users to work across different programs efficiently. 

 

SETTING UP A DOCUMENT 

Home Screen:  

First thing first, the Adobe Photoshop 2021 version or higher has a welcome screen that 

appears once you open the application. This will guide you to do things like creating a new 

If Photoshop is not 

possible, alternative 

Application can be used 

such as Gimp Photo 

editor. This is an open 

source which can be 

downloaded in this link: 

https://www.gimp.org/ 
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canvas, view previously created designs, or browse tutorials for new features and tricks in 

Photoshop.  

 

 

How to setup a new Document 

with Preset 

1. To set up a new document, 

click on the Create New 

button and a new dialog box 

will appear. This allows you 

to choose what type of 

document you wanted to 

create. Such as photo, 

printed, art & Illustration, 

web, mobile, film and video.  

2. You can also go to File > New at the top of the screen. Or just simply click Ctrl + N 

(win) or Cmd + N (Mac). Whichever way you choose, it will open a dialog where you 

can select the document size you want to use. 

3. At the New Document dialog box, select Print menu to show the different printable 

size document. 

4. Choose the Letter size and click Create. 

 

Placing and Transferring Images 

1. There are many options in 

opening an existing file or 

images in photoshop. The official 

way is: 

2. Click the Open button at the 

Home Screen, and it will show 

you the windows explorer where 

you can locate the image you 

want to open. 

3. Navigate to your image and 

select it. 
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4. Click Open. Then it will proceed 

to the Photoshop Interface.  

5. The Faster way in opening an 

image or design is by Drag and 

Drop from Windows Explorer 

location and dropping the image 

to the Photoshop Home Screen. 

6. If the existing file is already 

listed at the Home Screen 

displayed, just select and click 

and it will open at the Photoshop 

interface. 

 

2. Worked Example 

Practice navigating through Photoshop's interface. Open and close images, create new 

files, and save your work. 

3. Lesson Activity 

● Students will try to open their desired photo from their phone to photoshop.  

 

DAY 2 

SUB-TOPIC 3: NAVIGATION  

Interface: Photoshop's interface 

(also called Workspace) consists of 

various panels, menus, and 

toolbars that allow users to access 

its wide range of tools and 

functions. The workspace can be 

customized according to the user's 

preferences. It should look a little 

bit like the one shown below. 

Yours might look different, but it 

should look fairly similar. 

 

 

 

 

 

 

 

 

 

The teacher will facilitate 

the exploration of 

students in using 

Photoshop by opening 

and saving images. 

 

 

 

Use the Learning 

Activity Worksheet #1 

for this purpose. 
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An open image will sit on the canvas 

and you can open multiple images at 

one time. In my example, I have 2 

images opened and I can move between 

them by clicking on the Image Tab. 

 

Menu Bar  

Always located at the top of the screen. There are 12 

menus with many options’ underneath each. 

 

Click on each menu item to view its available 

options. Grayed-out options indicate they are 

currently unavailable. 

 

The availability of menu items varies depending on 

your activity. For instance, when you have a specific 

area of an image selected, most menu items under 

"Select" will be accessible. However, if there's no 

selection made, many of these options will appear 

grayed out. 

 

For illustration, consider the Filter menu below, which contains various sub-menu items such 

as 3D, Blur, Distort, and Sharpen, among others. Each of these items further expands into its 

own sub-menu. 

 

● Toolbar – set of tools placed on the left side of the screen that can manipulate photos in 

different ways. It was categories based on six functions. 

  

● Options Bar – this bar will interchangeably appear depending on the selected tool you 

clicked. These are additional options you can choose from in relation to the tool you are 

using. Example: Crop tool will show you suggested aspect Ratio you want to use or set 

the desired Ratio. You can also 

set the kind of grid guide you 

want to use. 
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● Photoshop Panels – placed on the right side of the screen, and like the toolbar, they can 

be dragged out and moved freely around the workspace. They provide lots of extra 

functionality.  

 

● Tools: Photoshop offers a vast array of tools for editing and creating images. Some of the 

essential tools include: 

 

● Move and Selection Tools: Used to move and select specific areas of an image. 

● Crop and Slice Tools: used to remove some unnecessary parts of the image. 

● Eyedropper and Measurement tools: for picking color and measuring image. 

● Retouching Tools and Painting Tools: Brush, pencil, eraser, 

etc., for digital painting clone stamp, healing brush, spot healing 

brush, etc., for retouching and repairing images. 

● Drawing and Type Tools: Used to draw shapes, trace, add and 

format text in images. 

● Navigation Tools: Scale, locate, zoom-in and zoom out images 

for better viewing. 

 

Note: Each tool has its additional tools hidden within itself. It can be 

accessed by click and hold the small arrow at the lower right corner of 

the tool. Then it will display while you can hover the mouse to select 

another tool. The figure below shows the detailed view of these tools. 

 

To show the meaning of all other tools, you may visit this website. 

https://www.photoshopessentials.com/basics/photoshop-tools-toolbar-overview/ 

 

Adobe Photoshop is a versatile and powerful tool for image editing and graphic design, offering a 

wide range of features and capabilities to unleash creativity and bring digital visions to life. 

 

2. Worked Example 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Logo Designing. Using 

Basic Shapes refer to the 

Learning Activity Sheet 

No. 2 
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Navigate the different tools as demonstrated by the teacher and practice the use of each 

tool while familiarizing the common tools that are frequently used for editing such as 

Moving, Cropping, Retouching, and Text tool. 

 

C. Lesson Activity 

● Students will demonstrate Logo Designing using Photoshop. 

 

DAY 3 

SUB-TOPIC 4: WORKING WITH IMAGES  

1. Explicitation 

Once the Image is already open in the Photoshop Interface, You can now manipulate 

and start the editing process.  

 

Basic Editing in Photoshop 

As a beginner in photo editing, you are expected to learn the basics of image editing which are 

presented below. 

a. Correcting - One of the first decisions you must 

make in editing a photo is to see to it that the 

white balance is in proper tone. Adjusts color 

balance, hue, saturation, and contrast to correct 

color casts or improve overall color accuracy.  

 

b. Levels and Curves: Allows precise adjustment of 

tonal range and contrast. Adjustments Layers: 

Non-destructive adjustments layers let you 

experiment with different corrections without 

permanently altering the original image. Camera 

Raw Filter: Provides advanced controls for 

adjusting exposure, white balance, clarity, and 

other parameters for raw image files. 

 

To correct any Image Adjustments, go to: 
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Image Menu > Adjustments > Select any option: Brightness/Contrast, Levels, Curves, 

Exposure.  

You may experiment with other options for 

Hue/Saturation. Color Balance and compare the 

actual result. 

c. Cropping - allows you to crop  

images to remove unwanted parts or to focus on a 

specific area. The Crop Tool enables you to define the 

area to keep and discard the rest of the images. You 

can adjust the crop boundary, aspect ratio, and 

resolution before finalizing the crop. Also, keep in 

mind the basic rules in composition. The Rule of Third. 

 

Use the Crop Tool to remove the unnecessary part of the 

picture. See image below. Then click and drag the mouse on 

the desired part of the image you want to retain and hit enter. 

 

d. Resizing and Compression - allows you to 

resize images to specific dimensions or percentages of 

their original size. 

You can change image dimensions without changing 

the aspect ratio by using the Image Size command. 

Additionally, Photoshop provides options for image 

compression to reduce file size while maintaining 

acceptable image quality. 

 

Save for Web: Allows you to optimize images for the web by 

adjusting quality settings, file format, and compression level 

to balance image quality with file size. 

 

Go to Image > Image Size > then Image Size Dialogue Box 

will appear: Adjust Width and Height with desired unit (Percent, Pixels, Inches, Centimeters, 

Points, Picas, Column). Then adjust Resolution to 300 for printable quality. 
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Resolution refers to the number of dots per 

inch (dpi) that appear in your images final 

form. For print these really may just be dots. 

On screen, however, these dots are referred to 

as pixels.  

● An image with high resolution (one 

produced for print, for example) will 

look very smooth and no pixilation 

(Standard Resolution is 300 dpi). An 

image with low resolution (one 

produced for the screen needs 72 

dpi) it may look far more pixelated if 

you zoom-in the image. 

e. Sharpening and Softening - is the last of 

the global corrections that are often applied 

to digital images to enhance clarity and 

details: 

Access Sharpening by selecting Filter > 

Sharpen > then select options for Sharpen. 

See the Screen Shot below. 

 

a. Sharpen Tool: Allows you to 

selectively sharpen specific areas of an 

image by painting over them. 

b. Shake Reduction: allows you to 

sharpen image from shaking shots. 

c. Smart Sharpen: Provides more advanced sharpening options, including 

noise reduction and halo suppression, with better control over sharpening effects. 

d. Unsharp Mask: A filter that increases the contrast along edges to make 

them appear sharper. 

 

f. Layering – is one of the important features in Photoshop that you need to 

understand. Usually, every element you add in your design should have its own 

layer. Usually, shapes, text, and images will create their own layer once added. So, 
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you should be mindful if you are already working in multiple layers. Applying 

commands or operations in a wrong layer may result in an undesirable outcome or 

no effect at all. 

 

Layer Panel can be accessed 

at the Right Panel of the 

Screen. If not visible, you can 

open it under Window > 

Layers or click F7 on your 

keyboard for shortcut 

command. 

The image has four main 

layers. One layer for picture, 

one for background, another 

layer for rectangle white shape 

and one folder for Text which 

has 3 layers of text inside. 

 

2. Worked Example 

 

Direction: Open the website bubbl.us. Complete the web Concept Map by enumerating the 

basics of photo editing. Give a brief description of each. Save as .jpg format then upload it in 

Google Classroom or Group Chat. 

 

 

3. Lesson Activity 

● Create a simple invitation design for 

your upcoming birthday in a 5x7 

inches (5R Size) Photopaper with at 

least 3 layers. 

 

 

DAY 4 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Refer to Learning 

Activity Sheet #3. 

 

 

 

The teacher will evaluate 

if the activity can be 

implemented in the 

Class. This activity is 

optional if the time 

allows. 
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SUB-TOPIC 5: Composition Techniques 

 

1. Explicitation 

Creating a Promotional Flyer in Photoshop. 

 

Watch the following video in YouTube and do the Learning Activity Sheet #5. 

Flyer Tutorial video in Youtube.com Video 1: 

https://www.youtube.com/watch?v=G7GGVWeWddg  

Flyer Tutorial video in Youtube.com Video 2: 

https://www.youtube.com/watch?v=prG-OpkJ9Xk  

Flyer Tutorial video in Youtube.com Video 3: 

https://www.youtube.com/watch?v=CuME6eLA3kw  

 

Rubric for Flyer Making. Please refer to Learning Activity Sheet # 5 

● This rubric assesses the students' ability to create a business flyer using Photoshop, 

focusing on design quality, information clarity, Photoshop skills, communication 

effectiveness, and neatness/organization. 

D. Making 

Generalizations 

1. Learners’ Takeaways 

Create a Cover Magazine Design with your picture. Use an appropriate Magazine Title 

related to your theme. Apply the principles and elements of design needed. Follow the 

Learning Activity Sheet for this Activity. 

 

2. Reflection on Learning 

Share what you have learned in this Lesson.  

● What are the Basic Photo Editing techniques that you can do in Adobe Photoshop? 

● What are the future projects do you think that you can do in Photoshop? 

● What is the importance of layering in Adobe photoshop? 

 

 

IV. EVALUATING LEARNING: FORMATIVE ASSESSMENT AND TEACHER’S REFLECTION NOTES TO TEACHERS 

A. Evaluating 

Learning 

1. Formative Assessment 

● Please refer to Learning Activity Sheet #6 - Formative Assessment. 
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Answer Key: 

1. C 

2. C 

3. B 

4. D 

5. C 

6. B 

7. C 

8. C 

9. D 

10. C 

11. C 

12. B 

13. A 

14. C 

15. C 

 

2. Homework (Optional)  

B. Teacher’s 

Remarks 

 

Note observations on any 

of the following areas: 
Effective Practices Problems Encountered 

The teacher may take note 

of some observations 

related to the effective 

practices and problems 

encountered after utilizing 

the different strategies, 

materials used, learner 

engagement and other 

related stuff.  

Teachers may also suggest 

ways to improve the 

different activities 

explored/ lesson exemplar. 

strategies explored   

materials used   

learner engagement/ 

interaction 

  

others   

C. Teacher’s 

Reflection  

 

Reflection guide or prompt can be on: 

▪ principles behind the teaching 

What principles and beliefs informed my lesson? 

Why did I teach the lesson the way I did? 

 

▪ students 

What roles did my students play in my lesson? 

What did my students learn? How did they learn? 

▪ ways forward 

What could I have done differently? 

What can I explore in the next lesson? 

Teacher’s reflection in 

every lesson conducted/ 

facilitated is essential and 

necessary to improve 

practice. You may also 

consider this as an input 

for the LAC/Collab 

sessions. 
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